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Beagle Bros' GS Font Editor is the first real font editor for GS fonts
available on the Apple II family of computers. It works on the
Apple lIe, IIc, IIc+ and IIgs. It's a powerful and quick program that
makes modifying existing fonts or creating new ones a breeze. GS
Font Editor gives you complete control over every aspect of a font.
You can change the font name, ID, size, ascent, descent, leading,
kerning and more. You can even scale a font from one size to any
other size! And GS Font Editor can edit fonts up to 127 points in size.
That's nearly two inches tall!

About the GS Font Editor disk

The GS Font Editor disk is nearly full, so any fonts you create will
most likely have to be saved on your own data disks. If you need to
format (initialize) a new data disk, use the System Utilities disk
or your own favorite disk management software. (Our personal
favorite around here is Randy Brandt's TimeOut FileMaster.)

The GS Font Editor disk comes with the following fonts: Times 72,
54,42, 36, 30, 27, Helvetica 72, 54,42, 36,30, 27, and Courier 72, 54,
42, 36, 30, 27.

The GS Font Editor disk is copyrighted but not copy-protected. That
means that while it is illegal to give away copies of this disk, you
can still easily copy it. We have done this for your convenience and
as a favor to you. Please do us a favor by living up to our trust and
not giving away copies of our software to other people. Thanks.

Make a back-up copy of the GS Font Editor disk now and put the
original in a safe place (out of the reach of little hands covered
with peanut butter and jam). You can use TimeOut FileMaster,
Diversi-Copy, Copy II Plus, Finder, System Utilities or Filer to
make the back-up.

Because the disk is unlocked and unprotected, you can transfer the
files from either the 51/4" disks or the 3 1/2" disk to a hard disk or
RAM disk. To transfer programs or fonts from one disk to another,
use TimeOut FileMaster, Copy II Plus, Finder, System Utilities or



Filer. (WARNING: make sure you use FILE COpy and not DISK
COpy when you want to copy selected files. Selecting Disk Copy
will wipe out the contents of the disk you are copying to.)

Mouse Required

GS Font Editor requires that you have a mouse to edit fonts. While
there are many keyboard shortcuts and commands, a mouse is
required. The use of the mouse in GS Font Editor is consistent with
the Apple Human Interface guidelines. That means if you've ever
used any mouse based software before (e.g., painting, drawing or
word processing programs) you won't have any trouble using GS Font
Editor.

If you've never used mouse software before, there are a few things
you need to know how to do:

1. Move the pointer around on the screen. Believe it or not, this is
accomplished by moving the mouse around on the desk.

2. Click the mouse button. To do this, press and release the button on
top of the mouse. Clicking is used to select an item on the screen
like a button, icon, name, or character.

3. Double click the mouse button. Hopefully you won't be surprised
to know that for this you press and release the mouse button
twice in a row. Double clicking is used as a short cut for selecting
an item and performing some action on it like opening a file,
choosing a character to edit, etc.

Note: We let you get a little lazy here. If the item is already
selected, you really only have to click on it once more to
accomplish the double click.

4. Drag the pointer. The pointer is the little arrow that moves
when you move the mouse. To drag the pointer, press the mouse
button and continue holding it down while moving the pointer.
Dragging is used to draw lines, boxes and circles, and to select
menu items.

Welcome to GS Font Editor 3



4 Chapter 1

5. Selecting menu items. To see a menu, position the pointer on one of
the menus in the menu bar, press the mouse button and hold it
down. To select a menu item from the menu, drag the pointer
down to the item and release the button. (Most menu items can
also be accessed with a keyboard shortcut.)

Printing Fonts

GS Font Editor can't print fonts on your printer. Use your favorite
software to print the fonts that you modify or create-TimeOut
SuperFonts, Publish-It, or practically any and all GS specific
software.

About this manual

The remainder of this manual is divided into three main sections:

Chapter 2: Anatomy of a GS Font

Chapter 3: GS Font Editor Tutorial

Chapter 4: GS Font Editor Reference

If you haven't done much "playing" with fonts, you will need to
read all of chapter 2, Anatomy of a GS Font. If you are somewhat
experienced with fonts, you can go straight to the tutorial in
chapter 3. And, if you are very familiar with GS style fonts, you
can skip the tutorial and head straight for chapter 4, GS Font
Editor Reference. Or, better yet, if you're a die-hard font nut you
probably don't even need to read this manual. In fact, you're
probably playing with the software right now and haven't even
cracked it open yet. Oh well.
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A font is a complete set of characters of one typeface. Every font has
a name (such as Chicago), and a size (such as 12) measured in
points. The font size may range from 1 to 127 points, but for
readability should be at least 6 points. Point is a typographical
term that stands for approximately 1/72 inch. The font size
measures the distance between the ascent line of one line of text and
the ascent line of the next line of single-spaced text.

Note: The actual font size may be slightly different from what
it would be in normal typography. Also be aware that two fonts
with the same font size may not appear to be the same size. The
font size is most useful for distinguishing different sizes of the
same font. (This is true even in typography.)

The font name and size are usually concatenated to form the
filename of the font (such as CHICAGO.12). However, this is not
required.

A font can consist of up to 255 distinct characters. Not all characters
need to be defined in a single font. Figure 1 shows the standard
characters in most fonts and their ASCII codes (for example, the
ASCII code for "A" is 41 hex or 65 decimal).

Note: Codes $00 through $lF (control characters) and code $7F
(delete) are normally non-printing characters.
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Each character in a font is defined by bits (or pixels) arranged in
rows and columns that form a rectangular array. This bit image is
called the character image. It's the image inside each of the
character rectangles shown in Figure 2.

r- character width-.
ascent line

font
height

font
heightcharacter

rectangle

base line

descent line

descent line

character
~-:--- rectang Ie

-.;--~+---;-- base line

:::::r::::r::::r..····
......................

......................

'-- image width --J

character/'or igin ~ (" ( ~

I.... image width-J

,..- character width -.
-.,....-- ascent line

character
origin

Figure 2.

The number of columns in a character image is called the image
width. Note that a character can have an image width of O. For
example, the space has a 0 image width. Its character image
consists of no pixels at all.
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The character rectangle is a rectangle that encloses the character
image. Its width is the image width of the character, which may
vary from character to character in a font. Its height is the
character height, which is the same for all characters in a font.

The character width is the number of pixels the pen position is to be
advanced after the character is drawn. (By the way, characters are
drawn by an imaginary pen!) This is different from the image
width, and the distinction between the two is important. For
example, the space character has 0 image width but does have
some character width, which determines the size of the space.
Some characters have a non-zero image width but a 0 character
width; an example of this is an umlaut 0, which is meant to be
typed over a vowel. The umlaut is drawn first, and then the vowel
is drawn with the same pen location.

The character origin is a point on the base line used to position the
pen for drawing. This point may be anywhere within the character
image. The character origin is the point where drawing of the
character starts.

For many letters, the character origin is located on the left edge of
the character image so that, when the character is drawn, its
leftmost pixel falls just to the right of the pen. (There's that
imaginary pen again.) Sometimes the character origin is between
pixels of the character image (or, rarely, entirely to the right of
the image). When such a character is drawn, some of its pixels will
fall to the left of the pen position. This is called kerning to the left.
In such a case, the distance, in pixels, from the character origin to
the left edge of the character is called the character's leftward
kern.

When character image pixels fall to the right of the new pen
position after the character is drawn, the character is said to kern
to the right. Kerning in either direction can cause letters to overlap
each other. (See Figure 2.)

Finally, for each character in a font there's a character offset. As
illustrated in Figure 3, the character offset is simply the difference
in position of the character rectangle for a given character and the
font rectangle.

Anatomy of a GS Font 9
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In addition to the terms used above to describe individual
characters, there are terms describing features of the font as a
whole. (See Figure 4.)
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The font rectangle is related to the character rectangle. Imagine
that all the character images in the font are superimposed with
their origins coinciding. (What a mess that would be.) The smallest
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rectangle that could enclose all the superimposed images is the font
rectangle.

The base line is a horizontal line along the bottom of each
character, above the descenders. The base line separates the
character into two sets of rows, one above and one below. The base
line is in the same horizontal position for every character in the
font.

The ascent is the distance from the base line to the top of the font
rectangle and is the horizontal line just above the top row of a
character.

The descent is the distance from the base line to the bottom of the
font rectangle and is the line just below the bottom row of characters
including descenders. A character's descender is the part of the
character that lies below the base line. Most characters don't have
a descender, but in the average font, characters like "g" and "y" do.

The height of the font rectangle is the font height, which is the
same as the height of each character rectangle. The maximum
height is 127 pixels. The maximum width by definition is 254
pixels. (Note that GS Font Editor artificially limits the maximum
width for an individual character to 128 pixels. This is no biggy.
We've yet to see a font, including extremely large ones, that even
comes close to half of that number.)

The leading is the amount of blank space between lines of single
spaced text-the distance between the descent line of one line of
text and the ascent line of the next line of text.

Every font has a bit image that contains a complete sequence of all
its character images. (See Figure 5.) The character images in the
font are stored in the bit image as though the characters were laid
out horizontally along a common base line. The character images in
the bit image touch each other; no blank space is left between them.

Anatomy of a GS Font
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Figure 5.

The bit image doesn't have to contain a character image for every
character in the font. Instead, any characters marked as being
missing from the font are omitted from the bit image. When a
program tries to draw these characters, a missing symbol is drawn
instead. The missing symbol is stored in the bit image after all the
other character images. In many fonts, the missing symbol is a
hollow rectangle.

Chapter 2
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GS Font Editor Tutorial
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The following section is a short step-by-step tutorial that helps
you quickly become familiar with GS Font Editor. It is a brief
overview of the basics of editing a font and is not intended to give a
detailed description of every aspect of GS Font Editor. For a more in
depth look at GS Font Editor, refer to the reference section.

Using GS Font Editor

Boot your GS Font Editor disk by placing it in your boot drive
(usually the first disk drive connected to your computer) and
pressing Control-Open Apple-Reset. (GS Font Editor can also be
started by double clicking on its icon while in the Finder, or by
selecting GSFE.5YSTEM from a program selector, or by typing 
GSFE.5YSTEM from the BASIC prompt.)

Soon you will see the Main screen.
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Notice that, in addition to the menu bar across the top of the screen,
there are two windows-the Font window and the Samples
window. The Font window shows the name of the font you are
editing and a 16 by 16 grid representing all the characters that are
in that font. Characters that have not been defined are blank. The
Samples window shows as many of the actual characters of the font
as will fit in the window. For a small font (14 point and under) you
should be able to see most of the characters.

For the purposes of this tutorial, rather than loading a font from
disk, we will just use the built-in, default font-ehicago.12. (For
information on loading a font file from disk, see the Open command
on page 32.)

Selecting a Character to Edit

To select a character to edit, move the pointer to the character you
want to edit and double click. For this tutorial, double click on the
letter "M". It is "pulled out" of the font and placed on the Edit
screen.

• File Edit Special
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I I
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Figure 7.
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Notice that there are now two new windows-the Character
window and the Styles window.

The Character window shows a magnified view of the character
that you chose (UM") and its name and ASCII equivalent (in hex
and decimal). Also situated in the Character window are the
editing tools and the editing window. The font rectangle controls
are the six little triangles at the bottom and right edges of the
Character window.

The Styles window lets you see how each character will look when
it has different styles applied to it. It shows plain, bold, italic,
underline, o1lJ1UJilme and s!hl<Bl(low.

Editing a Character

The default tool when you first start up the editor is the Pencil. You
can use the Pencil to both draw (turn on) and erase (tum oED pixels
(the black blocks) in the Character window. The Pencil will draw
in the opposite color of the pixel that you start on. To draw with
the Pencil just click the mouse button for single pixels or drag the
mouse with the button down for a continuous line. Each time you let
up on the mouse button the Styles window is updated. Play around
wi th Pencil now by making a few small changes to the letter "M".

Note: Drawing above the ascent control or below the descent
control is ignored when saving character changes. However,
drawing to the left of the origin control (left kerning) or to the
right of the width control (right kerning) will be saved with
the character.

Other Tools

There are seven other tools available to you while editing
characters: Marquee, Hand, Four Arrows, Eraser, Straight Edge,
Rectangle, and Oval.
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Draw a line with the Straight Edge by positioning the pointer to
the desired starting point for one end of the line and then dragging
to the other end.

While we're at it, go ahead and draw a rectangle and an oval with
their respective tools. Position the pointer to one corner and drag to
the other. Notice that as long as you continue to hold down the
mouse button you can make the rectangle or oval larger or smaller by
moving the pointer farther from or closer to the starting position.

Now select the Eraser tool and use it to clean up your mess. We'll
wait right here.

There are two other ways to erase things you have drawn in the
Character window-Undo and Revert. The Undo menu item in the
Edit menu will undo the last thing you did in the Character
window. The Revert menu item in the File menu will restore the
character being edited back to the way it was when you first began
editing it. This undoes all of your changes.

The Hand is used for moving the character around in the Character
window. This is especially important for very large fonts since you
may not be able to see all of a character at once. To use the Hand
tool, select it and then position the little hand in the editing
window and drag in any direction. Think of the hand as grabbing
the piece of paper you're drawing on and moving it.

The Four Arrows tool is similar to the hand tool except that it only
moves the font rectangle controls and not the character. This is
analogous to moving the lines on grid paper while leaving the
drawing in the same place. We're not sure why this is useful, but
the Macintosh font editors we've seen let you do this, so we figured
we had to let you do this too.

The Marquee tool, also called the Selection Rectangle or Editor's
Box, lets you select a rectangular portion of the editing window and
then cut, copy, or clear it. In addition, if you cut or copy a portion of
the editing window you can then paste that portion back anywhere
in the editing window.

This is a rather sketchy outline of the use of the tools. For more
detail, please refer to the reference section.

GS Font Editor Tutorial 17
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Font Rectangle Controls

The font rectangle controls are used to change the ascent, base line,
descent, leading, origin and width of characters as described in
chapter 2, Anatomy of a GS Font. To move the controls, position the
pointer on them and drag to the new location.

Note: Changing the origin or width controls only affects the
character you are currently editing. However, changing the
ascent, base line, descent or leading controls affects the entire
font (i.e. all characters). If you're not careful, you could
accidently cut the top or bottom off of every character in the
font. Don't be afraid to play with the controls though. Your
changes aren't implemented until you close the Character
window and return to the Main screen.

Close and Cancel Boxes

At the far left edge of the title bar of the Character window there
is a box called the Close box. Clicking in this box indicates that you
want to save any changes you made to the character and put it back
in the font.

Conversely, at the far right edge of the Character window title bar
is an X between two vertical bars. This is the Cancel box. Click in
this box if you want to throwaway any changes you made to the
character and return to the Main screen.

Click in the Cancel box and return to the Main screen.

Saving changes and QUitting

If we were really doing some serious editing and not just goofing off
we would want to save the changes made to the font before quitting.
This is easily done by selecting the Save menu item in the File
rrenu.



To quit GS Font Editor, just select Quit from the File menu and poof,
you're out. If you made changes to the font, you'll be asked if you
would like to save them before quitting. For this tutorial, you can
just answer No.

GS Font Editor Tutorial 19
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This section contains reference information that describes every
feature of GS Font Editor in detail.

Main Screen

The first thing you see when you start up GS Font Editor is the Main
screen.

• File Edit Special
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Figure 8.

The Main screen includes three major elements-the menu bar, the
Font window, and the Samples window. The menu bar has four
menus, Apple, File, Edit and Special, which each contain their own
menu items/commands. (The menus are discussed in detail later in
this chapter, see page 31.)



Font Window

The Font window is basically a 16 by 16 grid of all the possible
characters in a font (255) plus the missing symbol. The characters in
the Font window are not the actual characters of the font you are
editing. They are for reference only. The actual characters of the
font you are editing are displayed in the Samples window.

Missing Characters and the Missing Symbol

Not all characters need to be defined in a single font. The character
in the lower right-hand comer of the Font window represents the
missing symbol. The missing symbol is what is drawn, by most
software, in place of any missing (undefined) characters. For
example, in the Samples window, the actual missing symbol of the
current font is drawn for any characters that are undefined in that
font. In most fonts, the missing symbol is a hollow rectangle.
However, it can be anything-a vertical bar, a dot, etc.

Font Name and Font Size

The Font window also shows the filename of the current font that
you are editing. When you first start up GS Font Editor, the current
font is the default font, CHICAGO.12. (To load a different font
from disk for editing, see the explanation of the Open command on
page 32.)

The filename of a font is usually the concatenation of the font name
and the font size, however, this is not a requirement and is not
always the case.

Selecting a Character to Edit

To select a character to edit, move the pointer to the character and
double click. Double clicking a character in the Font window will
immediately take you the Edit screen where you can edit that
character.

Note: If the character you want to edit is already selected, you
really only have to click on it once more to select it for editing.
We knew that lazy people would love this one.
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Another way to choose a character for editing is to just type that
character on the keyboard. For the funny characters (foreign
language characters and special symbols) refer to the key chart in
the Appendix for information on how to type them.

Not all characters need to be defined in a font. Characters which
are not defined in the font you are editing are not shown in the Font
window (i.e. they look blank). The exceptions to this are Null
($00), Tab ($09), Return ($OD), Space ($20) and Delete ($7F). They
look blank in the Font window but they are usually defined in most
fonts.

You can select an undefined character for editing by double clicking
in its empty space in the Font window. This allows you to add
characters that didn't previously exist in the font.

You can edit the missing symbol in the lower right corner of the Font
window by double clicking on it.

Close Box

The close box in the upper left corner of the Font window may be
clicked on to close the current font. It is the equivalent of choosing
the Close command from the Files menu. (See page 34.)

Samples Window

The Samples window shows as many of the actual characters of the
current font as will fit in the window. For a small font (14 point and
under) you should be able to see most if not all of the characters. For
larger fonts, only as many characters as will fit will be shown in
the Samples window.

You will notice that whenever you load a new font, the Samples
window changes to reflect that font. Also after you have edited a
character, the changes will be reflected in the Samples window,
assuming of course that the character is shown in the Samples
window.



Typing in the Samples Window

If the Samples window doesn't show a particular character that
you want to see, or if you want to see how two or more letters look
together, you can type in the Samples window.

To type in the Samples window just click in it. This will erase all
the stuff we thought you wanted to see and make room for all the
stuff you really want to see.

Type the text you want. If you make a mistake, use the Delete key
to backup and make corrections.

If you want to you can press Return when you reach the end of the
line and the cursor will move down one line, right below the start of
the previous line. Otherwise the characters will automatically
wrap around to the next line. (There is no automatic word wrapping
however. What did you expect, MultiScribe GS!)

Note: Once you type in the Samples window, the only way to
get back the default samples is to type them yourself or load in
another font. Don't forget to save any changes you may have
made to the current font!

Extra Characters

Most fonts for the Apple II have 128 characters or less. GS style
fonts can have up to 255 characters. To type in characters beyond
the normal 128 that you are used to typing, see the key chart at the
end of the manual in the Appendix.
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Edit Screen

After selecting a character to edit, you will see the Edit screen.
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Figure 9.

The Edit screen includes three major elements-the menu bar, the
Character window, and the Styles window. The menu bar has four
menus, Apple, File, Edit and Special, which each contain their own
menu items/commands. (The menus are discussed in detail later in
this chapter, see page 31.)

Character Window

The Character window includes these items: the character name,
its ASCII code in hex and decimal, the tool palette, the font
rectangle controls, the editing window, and the close and cancel
boxes.

The editing window can be thought of as an actual window that
provides a 40 by 40 pixel view into a 128 by 128 pixel edit buffer.
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For most fonts, whole characters can easily be viewed in the editing
window. For very large fonts, you will need to use the hand tool to
see the different parts of a character.

The character itself is shown 4 times its actual size in the edit
window. This is very similar to the way FatBits (or Zoom) works in
most paint programs. Editing the character this way is a breeze
compared to trying to edit it in actual size, which would require the
eyes of Superman.

Character Name and Number

The character name (the letter it matches) and number (its ASCII
code, shown in hex and decimal) appear in the middle of the
Character window title bar. A character's image can be anything
you want it to be, so they come in handy when what you are editing
isn't actually a letter (e.g., a strawberry or a tree).

The Tools

The Tool palette contains all the tools that can be used to create
and modify characters. They are Marquee, Hand, Four Arrows,
Pencil, Eraser, Straight Edge, Rectangle and Oval. You can tell
which tool is currently selected because it is highlighted in the
Tool palette.

You will notice that the pointer takes different shapes depending
on the currently selected tool. For example, the pointer is shaped
like a crosshair when you select Oval, and it is shaped like a
rectangle when you select Eraser.

A description of each of the tools follows.

Marquee: The Marquee (sometimes referred to as the Selection
Rectangle or Edit Box) lets you select part of a character for further
editing action. Here's how to use the Marquee.

1. Select the Marquee tool.
2. Position the pointer on one corner of the area you want to edit and

then drag the pointer diagonally across the part of the
character you want to edit. A gray mask will be drawn over that
part of the character.
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3. Pull down the Edit menu and select the command you want to
perform.

Hand: The Hand tool is used for moving the character around in the
editing window. This is especially important for very large fonts
since you may not be able to see all of a character at once. To use the
Hand tool, select it and then position the little hand in the editing
window and drag in any direction.

Four Arrows: The Four Arrows tool is similar to the hand tool
except that it only moves the font rectangle controls and not the
character. This is analogous to moving the grid on your grid paper
while leaving your drawing in the same place. To use the Four
Arrows tool, select it and then position the little crosshair in the
editing window and drag in any direction.

We're not sure why this is useful, but the Macintosh font editors
we've seen let you do this so we figured we had to let you do this,
too.

Pencil: The Pencil tool lets you draw freehand while editing a
character. To use the Pencil, click to make individual points or drag
to make lines.

Note: Pressing the mouse button with the pencil will change
the pixel under the point of the pencil from white to black, or
black to white. And the pencil will continue to draw in that
color until you release the mouse button. This allows you to use
the pencil for drawing and erasing.

Eraser: The Eraser wipes clean any part of a character, quickly and
easily. To use the Eraser, click or drag the eraser on a character
wherever you want to erase.

Note: The eraser is good for erasing a wide path of pixels. If
you want to do precision erasing, use the pencil.

Straight Edge: The Straight Edge (sometimes referred to as a Line
tool) draws a straight line at any angle. To draw a line, position
the pointer to where you want one end of the line and then drag the
pointer to where you want the other end of the line.
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Rectangle: The Rectangle tool lets you draw rectangles in a
character. To draw a rectangle, position the pointer to where you
want one corner of the rectangle and then drag the pointer
diagonally until the rectangle is the size you want.

Oval: The Oval tool lets you draw ovals in a character. To draw an
oval, position the pointer to where you want to start the oval and
then drag the pointer in any direction until the oval is the size you
want.

Note: Drawing above the ascent control or below the descent
control is ignored when saving character changes. However,
drawing to the left of the origin control (left kerning) or to the
right of the width control (right kerning) will be saved with
the character.

Font Rectangle Controls

The font rectangle controls are used to change the ascent, base line,
descent, leading, origin and width of characters as described in
chapter 2, Anatomy of a GS Font. To move the controls, position the
pointer on them and drag to the new location.

Note: Changing the origin or width controls only affects the
character you are currently editing. However, changing the
ascent, base line, descent or leading controls affects the entire
font (i.e. all characters). If you're not careful, you could
accidently cut the top or bottom off of every character in the
font. Don't be afraid to play with the controls though, your
changes aren't implemented until you close the Character
window and return to the Main screen.

Changing the Origin and Width: The distance between the origin
and width controls determines the character width. Moving both
controls to the same position makes the character width zero.
(Remember, the character width is different than the image
width. The image width is the actual width of the pixels that
make up the character.)

The distance between the origin control and the leftmost pixel
determines how far the character will be drawn from the previous
character (position the origin control to the left of the leftmost
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pixel) or how much it will overlap the previous character (position
the origin control to the right of the leftmost pixel).

The distance between the width control and the rightmost pixel
determines how far the next character will be drawn from this
character (position the width control to the right of the rightmost
pixel) or how much this character will overlap the next character
(position the width control to the left of the rightmost pixel).

Note: If the origin and width controls occupy the same position,
the origin control will have to be moved to the left before the
width control can be moved.

Changing the Ascent, Base Line, Descent and Leading: The
base line control separates the ascender part of a character from the
descender part. The ascent control determines how far above the
base line a character may extend. The descent control determines
how far below the base line a character may extend. The ascent and
descent determine the font height.

The leading determines the amount of blank space between lines of
single-spaced text-the distance between the descent line of one
line of text and the ascent line of the next line of text.

Note: If the base line, descent or leading controls occupy the
same position, the lower control will have to be moved down
before the higher control can be moved (e.g., the leading control
would have to be moved down before the descent control could
be moved either way).

Close and Cancel Boxes

At the far left edge of the Character window title bar there is a box
called the Close box. Clicking in this box indicates that you want to
save any changes you made to the character and put it back in the
font (in memory, this has no affect on actual font on disk until you
do a Save) and return to the Main screen.

Conversely, at the far right edge of the Character window title bar
is an X between two vertical bars. This is the Cancel box. Click in
this box if you want to throwaway any changes you made to the
character and return to the Main screen.



Styles Window

The Styles window shows you the character that you are editing in
actual size and lets you see how it will look when it has different
styles applied to it. It shows plain, bold, italic, underline, o1ll.Hill!lle

and sllulclow.

Note: Actual size is a relative term. The actual size we are
referring to in the Styles window is approximately twice as
tall and twice as wide as what would be printed on the printer.

Turning Styles On and Off

The Styles window can be turned on and off with the Hide/Show
Styles command in the Special menu (see Hide/Show Styles on
page 41.)

The Menus

A description of each of the menus and their respective menu items
follows. (Shortcut keystrokes are listed in parenthesis after each
menu item.)

The Apple Menu

About... (0 ?)

Selecting About will show the version number of GS Font Editor.
Click on the OK button (or press Return) to leave this dialog box.
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The File Menu

The File menu has the following commands: New, Open, Close,
Save, Save As, Revert, and Quit. A description of each item
follows.

New (0 N)

New is a dual function menu item, depending on whether you are on
the Main screen or the Edit screen.

From the Main screen (looking at the Font window):
Selecting New will clear the current font from memory. The font
size of the new "empty" font will be the same as the font previously
in memory. However, you can change the size to anything you want.

If you have not saved the current font or if you have made changes
to it since you last saved it, you will be asked if you would like to
save it before starting a new one. Your options are Yes, No, and
Cancel. Choosing Yes (by clicking on the Yes button or pressing "Y"
or Return) will save the font under the current filename. Choosing
No (by clicking on the No button or pressing "N") will go ahead and
erase the font from memory. Choosing Cancel (by clicking on the
Cancel button or pressing Escape) will return you to the current font.

From the Edit screen (looking at the Character window):
Selecting New from this screen will erase the character you are
working on and let you start with an empty editing window.

If you accidentally erase a character, you can restore it by choosing
the Revert command in the File menu.

Open (00)

Selecting Open will show you a list of all the GS style fonts on the
current disk. If there are more than 8 fonts, you can click on the
Arrows in the Scroll Bar (to the right of the font names) to scroll
through the list.



Disk

Open

IGSIFOHT.EDITOR

Figure 10.

To select a font to open, click on its name (to highlight it) and then
click on the Open button or press Return. As a shortcut, you can open
a file by double clicking on its name.

If you decide not to open a font, click on the Cancel button (or press
Escape).

If you select a font to be opened and haven't saved the current font,
you will be asked if you would like to save the current font before
opening the new one. Your options are Yes, No, and Cancel.
Choosing Yes will save the current font and then open the new one.
Choosing 1\.'0 will go ahead and open the new font without saving
the current font. Choosing Cancel will abort the Open command and
return you to the current font.

Subdirectories: After you choose Open and have a list of files, you
may notice a "/" after some names. This tells you that it's a
subdirectory rather than a font. You can open a subdirectory and see
all the fonts that are in it by selecting it and clicking the Open
button or by double clicking on it.
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To back up to the directory you were in before you opened a
subdirectory just click on the directory name at the upper left corner
of the Open dialog. If the directory name begins with a "I", you are
at the volume (main) directory and can't back up any more.

Disk: Clicking on the Disk button will display the fonts on the next
available disk drive.

Keyboard Shortcuts: Pressing Return is the same as clicking the
Open button. Tab is the same as Disk and Escape is the same as
Cancel.

Close (0 W)

Selecting Close (or clicking in the close box on the title bar of the
Font window) allows you to close the current font. If you haven't
saved the current font since making changes to it, you will be asked
if you would like to save the font before closing. Your options are
Yes, No, and Cancel. Choosing Yes will save the font under the
current filename and then close it. Choosing No will go ahead and
close it without saving the current font. Choosing Cancel will return
you to whatever you were doing before you selected Close.

Save (0 S)

Selecting Save will save the current font without prompting for a
name. The current filename will be used. (The current filename is
the name of the most recently opened or saved font.) Fonts are
always saved as GS fonts.

Save As... (0 A)

Selecting Save As will let you save the current font under the name
of your choosing. You will see the current directory along with the
current font name and will be prompted for the new name. Although
not required, we recommend ending all font names with the size so
that they can be easily identified later when you look at a list of
the fonts on a particular disk.
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If you make a mistake while entering the name, use the Delete key
to backup and make corrections. After typing in the new name, click
on the Save button (or press Return). If you do not want to save the
font, click on the Cancel button (or press Escape).

Note on Filenames: When you save a file on disk, the name you
give it must follow certain naming conventions. All names must start
with a letter (A-Z) and may consist of letters, numbers and periods
only. The maximum length for a name is 15 characters. Here are a
few examples:

Good names

FONT.12
TEST.FONT.24

Bad names

NEW FONT
36.FONT
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Revert (0 R)

Revert is a dual function menu item, depending on whether you are
on the Main screen or the Edit screen.

From the Main screen (looking at the Font window):
Selecting Revert will let you revert to the last saved version of your
current font. Click on the OK button (or press Return) to proceed or,
if you don't want to revert, click on the Cancel button (or press
Escape).

From the Edit screen (looking at the Character window):
Selecting Revert will throwaway all changes you have made to
the character and revert to the way it was when you selected it for
editing.

Quit (0 Q)

Selecting Quit allows you to leave GS Font Editor and start another
application. You will be asked if you really want to quit. If you
haven't saved the current font since making changes to it, you will
be asked if you would like to save the font before quitting. Your
options are Yes, No, and Cancel. Choosing Yes will save the font
under the current filename and then quit. Choosing No will go
ahead and quit without saving. Choosing Cancel will return you to
whatever you were doing before you selected Quit.

The Edit Menu

The Edit menu has the following commands: Undo, Cut, Copy,
Paste, Clear, and Show Clipboard. A description of each command
follows.

Undo (0 Z)

Undo is a dual function menu item, depending on whether you are on
the Main screen or the Edit screen.

Show Clipboard
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From the Main screen (looking at the Font window):
The Undo command will undo the last change you made to the font.
For example, if you cut or cleared a character from the font, Undo
can put the character back. This only works on the last character
that was cut, cleared or pasted on top of. To undo everything, use
the Revert command.

From the Edit screen (looking at the Character window):
The Undo command will undo the last change you made to the
character you are editing, returning it to its previous state. If you
want to undo something, you must use this command right away,
because it only works on the very last thing you did (i.e. the most
recent click or drag of the pointer that affected your drawing).

For example, you can use Undo to undo rectangles, ovals, lines,
erasures, etc.

Cut (0 X)

Cut is a dual function menu item, depending on whether you are on
the Main screen or the Edit screen.

From the Main screen (looking at the Font window):
The Cut command cuts out the character that's currently selected.
The character that is cut out is removed from the font but it's saved
in memory so that you can paste it back if you want. You can even
paste it on top of another character.

From the Edit screen (looking at the Character window):
The Cut command cuts out the part of the character that's inside
the Marquee. The part that is cut out is removed from the editing
window but it's saved in memory so that you can paste it back if you
want. Here's how to cut:

1. Select the Marquee tool.
2. Drag the pointer diagonally across the area you want to cut out.
3. Pull down the Edit menu and select Cut. The part of the

character inside the Marquee will be removed.

If you accidentally cut out part of a character, you can restore it by
immediately selecting Undo.
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If you want to put the cut out part of a character somewhere else on
the character, use Paste.

Caution: If you perform two (2) Cut commands in a row, the clipping
from the first one will be destroyed. Only the most recently cut
clipping is saved.

Copy (0 C)

Copy is a dual function menu item, depending on whether you are on
the Main screen or the Edit screen.

From the Main screen (looking at the Font window):
The Copy command copies the character that's currently selected.
The copy is saved in memory so that you can paste it somewhere
else if you want (i.e. on top of another character).

From the Edit screen (looking at the Character window):
The Copy command duplicates the part of the character that's
inside the Marquee, without removing it from the character. The
part that is copied is saved in memory so that you can paste a copy
somewhere else on the character. Here's how to copy:

1. Select the Marquee tool.
2. Drag the pointer diagonally across the area you want to copy.
3. Pull down the Edit menu and select Copy. The part of the

character inside the Marquee will be copied to memory.

Paste (0 V)

Paste is a dual function menu item, depending on whether you are on
the Main screen or the Edit screen.

From the Main screen (looking at the Font window):
The Paste command puts back the character that you Cut, or
duplicates the character that you Copied.



From the Edit screen (looking at the Character window):
The Paste command puts back the part of the character that you
Cut, or duplicates the part that you Copied. To paste a clipping
into a new location:

1. Pull down the Edit menu and select Paste.
2. Move the pointer (which is now a box the size of the area to be

pasted) to any position in the editing window.
3. Click the button. The previously cut or copied clipping will be

placed in the editing window.

You can paste as many times as you like, which means that you can
put multiple copies of one clipping in as many different places in
the character as you want.

To get out of Paste mode, click on the Marquee tool or any other tool.

Clear (0 Y)

Clear is a dual function menu item, depending on whether you are on
the Main screen or the Edit screen.

From the Main screen (looking at the Font window):
The Clear command erases the currently selected character from
the font. You would probably use this command to get rid of unused
characters in a font to make room for scaling to a bigger size.

From the Edit screen (looking at the Character window):
The Clear command erases everything inside the Marquee. This is a
handy way to erase a large section of a character. Use Undo if you
selected this command accidentally.

Show Clipboard (0 K)

Selecting Show Clipboard will show the current contents of the
clipboard. It could be a whole character if you're on the Main
screen, or a piece of a character if you're on the Edit screen. Click on
the OK button (or press Return) when you're through viewing the
clipboard.
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The Special Menu

The Special menu contains miscellaneous commands that help you
in font editing. The commands are Scale, Hide/Show Styles, Get
Info, Edit Next, and Edit Previous.

Well, isn't that special! Here is a description of each.

Scale Font... (0 F)

The Scale Font command lets you scale an entire font to make it
larger or smaller. It can scale from any size to any size. The only
restriction is that the new size must be smaller than 127 points tall
and also must be able to fit in memory. You'll receive a warning
message if the final size would be too large.

The current size is shown as the "From" size, just type in the "To"
size. Because the vertical and horizontal sizes are entered
separately, you can scale in one dimension more or less than the
other (e.g., you can make a font short and fat, or tall and skinny).

Note: The scaling is actually based on the ratio of the "From"
and "To" sizes. So, to make a 12 point font twice as big ,you
could either enter 12 and 24 as "From" and "To" respectively or
enter 1 and 2 as "From" and "To n. The ratio is the same. (Both
numbers must be less than 128.)
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Press Tab to move from one field to the next. Use Delete to erase a
value and enter a new one. After entering the desired sizes, click
the OK button (or press Return) to continue with the scaling, or click
the Cancel button (or press Escape) to abort the scale operation.

Note: Scaling a font cannot be undone with the Undo command.
However, if the font has been previously saved on disk, you can
use Revert to return to the font the way it was before scaling.

Hide/Show Styles (0 H)

The Styles window can be turned on and off with the Hide/Show
Styles toggle command in the Special menu.

Selecting Hide Styles from the Main screen before selecting a
character to edit will prevent the Styles window from being
displayed while you are editing. Selecting Show Styles will
display the Styles window while editing.
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We included the ability to disable the display of styling for those
of you that aren't patient enough to wait the split second it usually
takes to update the Styles window. (Actually, for extremely
complex characters, it can take up to 5 seconds to update the Styles
window. What an eternity!)

Note: Here's a neat trick. If you select Hide Styles from the
Edit screen (i.e. while you are editing a character) the Styles
window will continue to be displayed but won't be updated as
you edit the character. When you're ready to update the styles
again, just select Show Styles and they will be updated.

Get Info (0 I)

Selecting Get Info will show you the font name, font size and font ID
number of the current font. You can also modify these values. Press
Tab to move from one field to the next. Use the Delete key to erase
the current entry and then enter a new one.

Font NaNe:
IChicago
!

Size:

Chapter 4

112
ID:

Figure 13.
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Clicking the OK button (or pressing Return) will save any changes
you made. Clicking Cancel (or pressing Escape) \\';11 discard any
changes and the previous values will remain unchanged.

Every font has a name (such as Chicago), and a size (such as 12)
measured in points. The font name must be less than 26 characters in
length. The font size may range from 1 to 127 points. (See the
information on font size in chapter 2, Anatomy of a GS Font.)

The font name and size that we are referring to here are different
than the filename of the font, which for most fonts also includes a
name and size. The font name and size are actually stored within
the font itself. They are usually concatenated to form the filename
of the font (such as CHICAGO.12). However, this is not required
and is not always the case.

Font ID numbers are strange animals that are used to identify
families of fonts and are best left alone. (We know you hackers out
there think you need to play with this number, so we gave you
access to it. Have a ball.)

Edit Next (0 -»

Selecting Edit Next will close the current character, save any
changes, and present the next character in the editing window. For
example, if you were editing the character "A", after selecting Edit
Next or pressing Open Apple-->, "A" would be saved and "B"
would be opened up for editing. This saves the time normally
required to close the character, go back to the Main screen and
choose the next character for editing.

This command works from both the Main and Edit screens.

Edit Previous (0 <-)

Edit Previous is similar to Edit Next. Selecting it will close the
current character, save any changes, and present the previous
character in the editing window. For example, if you were editing
the character "B", after selecting Edit Previous or pressing Open
Apple-<-, "B" would be saved and "A" would be opened up for
editing. This saves the time normally required to close the
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character, go back to the Main screen and choose the previous
character for editing.

This command works from both the Main and Edit screens.
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Appendix

32K Limit

Fonts are limited to 32,768 bytes. This is more than adequate for
most fonts. However, if you want to create a very large font (say, 72
point or larger), you may have to break the font up into 2 or more
files. We recommend putting upper case letters and numbers in one
file and lower case letters and special characters in a second file.

High Quality Printing

Be aware that most programs try to use a font twice the size of the
one you've indicated when they print in high quality mode. When
you print in high quality mode, you won't see the changes if there is
a font twice its size that doesn't incorporate the same changes. If
there is no font that's twice the size, no problem, you'll see your
changes in the print outs.

Key Chart

The figure below shows how to access each character in the font
from the keyboard. These keystrokes are entered differently.
Single key sequences are easy. Just press the key corresponding to
the character you want.

To enter the key sequences beginning with OPT (meaning Option
also known as the Solid Apple key), just hold down the Option key,
then press and release the second key.

The S-O sequence means Shift and Option together. Hold both
these keys down and press and release the last key.

Codes that start with 0- require the Option key and the second key
in the sequence to be pressed and released. Then press the last key
in the sequence.



0

2

3

4

- 5
.2'

60
x
(1) 7I
"0 8c
0
<..l

9(1)
(f)

A

B

C

D

E

F

First Hex Digit

023 4 5 6 7 8 9 ABC D E F
cntrl cntrl

0 @ p ,
p

O-u 0-; OPT OPT S-O OPT S-O S-O
(@ P spc A e t 5 / - 7 k

entrl cntfl ! 1 A Q s-o O-u s-o S-O OPT S-O S-O s-o
A Q a q a e 8 = 1 - 9 I

ent,l ent,l
" 2 B R b

s-o O-e OPT OPT OPT OPT S-O S-O

B R r c i 4 , I [ 0 ,
ent,l ent'l

# 3 C S c S
O-e 0-' OPT OPT OPT S-O S-O S-O

C S E i 3 y [ W Z
ent,l ent'l

$ 4 D T d t
O-n 0-; OPT OPT OPT OPT S-O S-O

0 T N i 6 Y f ] e x
cntrl cntrl 0/0 5 E U e O-u O-u OPT OPT OPT S-O S-O S-O

E U U 0 i 8 m x ] r b
cntrl entrl & 6 F V f O-u O-n OPT OPT OPT OPT S-O S-O

F V V U n 7 d j / t n
ent,l ent,l ,

7 G W 9
O-e O-e OPT OPT OPT S-O S-O S-O

G W W a 0 s w \ y Y m
entrl ent,l

( 8 H X h 0-' 0-' OPT S-O S-O O-u S-O S-O

H X X a 0 r p \ Y u .
entrl cntrl ) 9 I Y i 0-; 0-; OPT OPT OPT S;O S-O S-O

I Y Y a 0 9 P , i
cntrl entd * J Z j O-u O-u OPT OPT OPT S-O S-O OPT

J Z Z a a 2 b SPc 1 s h
cntrl entrl K [ k { O-n O-n O-e OPT 0-' S-O S-O OPT

K r + , a 0 O-e 9 A 2 d k
ent,l ent,l

L \ I I
OPT O-e O-u OPT O-n S-O S-O

L \ , < a u O-u 0 A 3 f
ent,l cTr, M ] m } OPT 0-' OPT OPT O-n S-O S-O

M - = C U = Z 0 4 9
entrl cntf! N 1\ O-e 0-; S;O OPT S-O S-O S-O

N A > n - e u q 5 h
cntrl entd / ? 0 0 del

0-' O-u S-O OPT OPT S-O S-O

0 - e u a 0 q 6 j

Figure 14_
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Open Apple Shortcuts for menu items

Apple
About... O?

File
New ON

Open 00
Close ow
Save OS
Save As... OA
Revert OR
Quit OQ

Edit
Undo 02
Cut OX
Copy OC
Paste OY
Clear OY
Show Clipboard OK

Special
Scale Font... OF
Hide/Show Styles OH
Get Info 01
Edit Next 0->
Edit Previous 0<-



Help!

Customer Support Information

If you have questions or problems that your dealer can't answer, you
can contact the Beagle Bros Customer Support Staff for expert
assistance.

Before calling, check the instruction manual to see if it contains the
information you need. Write down a complete description of the
problem, the version number of the software, and the names and
version numbers of any other programs you're using in connection
with our software.

If you have a modem, you may also receive Technical Support on our
24-hour Customer Support System. The system provides an
electronic mail and conferencing system, along with the latest
information about product updates and changes.

Customer Support:
(619) 452-5502 8 am to 5 pm, weekdays (Pacific time)

Modem Technical Support:
(619) 558-6151 24 hours, every day

Fax:
(619) 452-6374 24 hours, every day

Or, you can write to:
Beagle Bros, Inc.
6215 Ferris Square, Suite 100
San Diego, CA 92121
Attn: Customer Support

Help! 49
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32K limit 46
About 31
Applemenu 31
Ascent 11, 16, 18, 29, 30
Back-up 2
Baseline 11,18,29,30
Bits 8
Cancel box 18,30
Character image 8
Character name 27
Character number 27
Character offset 9
Character origin 9
Character rectangle 9
Character width 9
Character window 16,26
Clear 39
Click 3
Close 34
Close box 18,24,30
Copy 38
Customer support 49
Cut 37
Data disks 2
Descent 11, 16, 18,29,30
Disk 34
Double click 3
Drag 3
Editmenu 36
Edit Next 43
Edit Previous 43
Edit screen 15,26
Editing a character 16
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Editing window 16,27
Eraser 17, 28
Extra characters 25
Filemenu 32
Filename 23, 35
Font Height 11
Font ID number 43
Font name 6,23,43
Font rectangle 10
Font rectangle controls 16,18,29
Font size 6,23,43
Font window IS, 23
Foreign language characters 24
Four Arrows 17, 28
From size 40
Get Info 42
Hand 17,28
Help 49
Hide Styles 41
High quality printing 46
Image width 8
Included Fonts 2
Kerning 9,16
Key chart 46
Keyboard shortcuts 34,48
Leading 11,18,29,30
Main screen 14,22
Marquee 17, 27
Menu Items 4
Menus 31
Missing characters 23
Missing Symbol 12,23,24
Mouse 3
New 32
Open 32
Origin 16, 18,29
Oval 17,29
Paste 38
Pencil 16,28
Pixels 8
Point 6
Pointer 3,27



Printing 4, 46
Quit 18,36
Rectangle 17, 29
Revert 17, 36
Samples window 15,24
Save 18,34
Save As 34
Scale Font 40
Selecting a character 15, 23
Shortcuts 34,48
Show Clipboard 39
Show Styles 41
Special menu 40
Special symbols 24
Start up 14
Straight Edge 17, 28
Styles window 16,31
Subdirectories 33
Technical support 49
To size 40
Tools 16,27
Trouble shooting 49
Typing in the Samples window 25
Undo 17,36
Width 16, 18,29
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